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Author Questionnaire

1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  Enter Yes or No.  
If Yes, can you record movies/images using your own microscope camera?
Enter Yes or No.  
If your protocol involves microscopy but you are not able to record movies/images with your microscope camera, JoVE will need to use our scope kit. 
If your microscope does not have a camera port, the scope kit will be attached to one of the eyepieces and you will have to perform the procedure using one eye.
Enter make and model of microscope.
If a dissection or stereo microscope is required for your protocol, please list all shots from the script that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).
Click here to list microscope shots, using the shot numbers from the protocol section of the video script.

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Enter Yes or No.
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k
As these files are necessary for finalizing your script, please upload all screen-captured video files to your project page as soon as possible.: https://review.jove.com/account/file-uploader?src=21126788

3. Filming location: Will the filming need to take place in multiple locations?   Enter Yes or No.
If Yes, how far apart are the locations? Click to enter distance between locations.


4. Testimonials (optional): Would you be open to filming two short testimonial statements live during your JoVE shoot? These will not appear in your JoVE video but may be used in JoVE’s promotional materials. Enter Yes or No.  
If Yes, please provide the full name and position (e.g., Director of [Institute Name], Senior Researcher [University Name], etc.) of the author willing to participate.
Enter full author name, Enter author position


To ensure that your script can be filmed in one day, the protocol sections are cumulatively restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)


Current Protocol Length
Number of Steps: 17
Number of Shots: 38

Introduction
Videographer: Obtain headshots for all authors available at the filming location. 

Answers to these questions will become interview statements that you will deliver on camera.
· Answer up to 2 introduction and up to 3 conclusion questions. No more than 5 interview statements will be included in the video.
· Enter the full name of the author who will deliver the statement.
· Speak naturally and avoid reading the lines.
· Answer in full sentences, the questions will not be displayed in the video. 
· Limit the length of each statement to 20 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

INTRODUCTION:

What is the scope of your research? What questions are you trying to answer? 
1.1. Enter author name.: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.

What are the most recent developments in your field of research?
1.2. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What technologies are currently used to advance research in your field?
1.3. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What are the current experimental challenges?
1.4. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.

CONCLUSION:

What significant findings have you established in your field?
1.5. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.

What research gap are you addressing with your protocol?
1.6. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.

What advantage does your protocol offer compared to other techniques?
1.7. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
How will your findings advance research in your field?
1.8. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What new scientific questions have your results paved the way for?
1.9. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What questions will future research focus on?
1.10. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.


Videographer: Obtain headshots for all authors available at the filming location.


Ethics Title Card
This research has been approved by the Institutional Animal Care and Use Committee (IACUC) at Temple University



Protocol  
[bookmark: _Hlk188263998]Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The two-digit steps (e.g., 2.1., 2.2.) with purple font are the narration.  JoVE is responsible for the narration of the protocol and results.
· Red italics are pronunciation guides indicating how the word will be spoken. 
· Filming should take no more than 10 minutes per step. If a step takes more than 10 minutes, prepare the product for that step in advance.
· The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that the videographer will capture. 

2. Imaging and Quantitative Analysis of Mitochondrial Fusion in Cisplatin-Treated Cells
Demonstrator: Click here to enter name of demonstrator(s) 

If the same person is the demonstrator throughout, mention them once here and remove the "Demonstrator" field from the other sections; if the demonstrator changes, retain the field in the respective sections.

2.1. To begin, seed kidney proximal tubular cells in glass-bottom culture plates [1-TXT]. Incubate the cells overnight to allow for adherence and growth [2]. The next day, add cisplatin to the experimental plate to a final concentration of 2 micromolar [3-TXT]. 
2.1.1. WIDE: Talent pipetting cell suspension into multiple wells of a glass-bottom culture plate. TXT: Seeding density: 1 - 5 × 105 cells/well depending on experimental requirements
2.1.2. Shot of the culture plate placed inside the incubator.
2.1.3. Talent pipetting cisplatin into the well of a culture plate inside a biosafety cabinet. TXT: Ensure 0.004% final concentration of DMSO
2.2. Next, configure the lasers of a confocal microscope to 405 nanometers, 488 nanometers for unconverted Dendra2 excitation, and 561 nanometers [1]. Turn on the lasers and allow approximately 10 minutes for stabilization [2].
Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible: https://review.jove.com/account/file-uploader?src=21126788
2.2.1. SCREEN: Talent adjusting the laser configuration on the software. 
2.2.2. SCREEN: Talent switching on the lasers. 
2.3. Place the culture disc in the incubation chamber [1]. Add water around the chamber and set the temperature to 37 degrees Celsius, ensuring the supply of carbon dioxide is maintained [2]. Allow the incubation chamber to equilibrate before imaging [3].
2.3.1. Talent carefully placing a culture disc inside the incubation chamber.
2.3.2. Close-up of the water tray being filled and the control panel showing 37 degrees Celsius and CO₂ indicator.
2.3.3. Shot of the incubation chamber closed with timer or indicator light on.
2.4. Visualize the cells using higher magnification and resolution for mitochondrial imaging [1]. Open the drop-down menu in the top-left corner and select the FRAP (frapp) options [2].
2.4.1. SCOPE/SCREEN: Image of the mitochondria at high resolution is being seen.
2.4.2. SCREEN: Software interface with drop-down menu open and FRAP option selected.
2.5. Using LAS X (Las-Ex) software, define the region of interest where photobleaching will be performed [1]. Set lasers to 405 nanometers at 0.00, 488 nanometers at 0.20, and 561 nanometers at 0.20, and ensure the cells are in focus [2]. Then acquire a series of pre-bleach images at low laser intensity to establish baseline fluorescence intensity by [3].
2.5.1. SCREEN: ROI is being defined on the LAS-X software. 
2.5.2. SCREEN: The laser intensity is being changed and the cells are being focused. 
2.5.3.  SCREEN: Pre-bleach image acquisition is being done. 
2.6. Now apply a high-intensity laser pulse to bleach the region of interest by setting FRAP lasers to 405 nanometers at 4.00, 488 nanometers at 0.00, and 561 nanometers at 0.00 [1]. Set the pre-bleach to 5.140 seconds for 59 iterations and define the post-bleach timing [2]. 
2.6.1. SCREEN: Laser settings showing high-intensity values configured for bleaching.
2.6.2. SCREEN: The pre-bleach settings are being defined.  
2.7. For post-bleach imaging, continue to acquire images at low laser intensity for 10 minutes using FRAP lasers at 405 nanometers at 0.00, 488 nanometers at 0.50, and 561 nanometers at 0.50 [1].
2.7.1. SCREEN: The laser intensity is being changed for post-bleach imaging. 
2.8. To profile the merged green and red mitochondria, first install the RGB profiler plugin [1]. Open ImageJ software [2], then from the File menu, locate and open the image file to analyse [3].
2.8.1. SCREEN: Fiji interface showing RGB profiler plugin being installed from the plugin menu.
2.8.2. SCREEN: Desktop shortcut of ImageJ being opened.
2.8.3. SCREEN: File browser in ImageJ selecting an image file.
2.9. Select the color mode composite, check the Auto Scale option, and open the video or image stack to analyze [1]. Draw a rectangular area over the image [2] and right-click to select Duplicate [3].
2.9.1. SCREEN: ImageJ interface showing color mode set to composite and Auto Scale checkbox enabled then the video or image stack is being opened. 
2.9.2. SCREEN: Rectangular selection tool being used to highlight a section of mitochondria.
2.9.3. SCREEN: Right-click context menu with Duplicate option selected.
2.10. Select the duplicate hyper stack option to duplicate all the image stacks [1]. Select the image and choose RGB in the Image dropdown menu To convert the duplicated stack to RGB format [2].
2.10.1. SCREEN: Dialog box showing Duplicate Hyperstack option checked.
2.10.2. SCREEN: Image > Type > RGB option selected in the ImageJ menu.
2.11. Duplicate the RGB image and select only one frame [1]. If the mitochondria appear curved, draw a line along their length [2], then go to the Edit menu, choose Selection, and click Straighten [3].
2.11.1. SCREEN: RGB image being duplicated and one frame selected.
2.11.2. SCREEN: Curved mitochondrion are being traced.
2.11.3. SCREEN: Edit > Selection > Straighten option selected.
2.12. Now choose a title for the straightened image and set the line width to 20 pixels [1]. Draw a line along the straightened mitochondrion to align it properly [2] and open the RGB profiler plugin [3].
2.12.1. SCREEN: Input field for image title and line width set to 20 pixels.
2.12.2. SCREEN: Line tool used to draw along the mitochondrion in the straightened image.
2.12.3. SCREEN: RGB profiler plugin interface being launched.
2.13. Once activated, the plugin will generate a plot showing red and green fluorescence intensities along the drawn line [1]. The height of each peak will be directly proportional to the fluorescence intensity [2].
2.13.1. SCREEN: Plot showing two lines corresponding to red and green signals across the selected path.
2.13.2. SCREEN: Peak heights visualized and labeled to indicate intensity values.
2.14. Before mitochondrial fusion, confirm that red fluorescence is localized to one mitochondrion, and green fluorescence is localized to an adjacent one [1]. Verify that the corresponding intensity plot displays two distinct peaks with minimal overlap [2].
2.14.1. SCOPE/SCREEN: Mitochondrial pair with clearly separated red and green fluorescence are being seen.
AUTHORS: Please use the cursor to show the clearly differentiated colors
2.14.2. SCREEN: Intensity plot showing distinct red and green peaks.
AUTHORS: Please use the cursor to hover over the 2 distinct peaks
2.15. After fusion, confirm that the red fluorescence has spread into the adjacent green mitochondrion indicating content mixing [1]. Verify that the intensity plot now shows overlapping red and green peaks [2].
2.15.1. SCOPE/SCREEN: Fused mitochondrion showing blended red and green signal.
2.15.2. SCREEN: Updated plot showing overlapping peaks.
2.16. To assess fusion, select healthy mitochondria and photobleached mitochondria for fusion in live cell imaging [1]. Monitor the change in red to green fluorescence ratio over time to indicate fusion events [2].
2.16.1. SCOPE/SCREEN: Field showing selection of intact and bleached mitochondria.
2.16.2. SCREEN: Time-series graph displaying the ratio shift of red to green fluorescence over time.

2.16.3. 

Results
Please review this section to make sure that it accurately reflects your findings.
· This section will not be recorded by the videographer. It only includes the figures/tables from your manuscript (called LAB MEDIA). 
· Use Track Changes when making edits or revisions. Ensure the voiceover length is below 200 words. Current word count: 98
· Please note that the video cannot include voiceover without an accompanying visual.

3. Results 

3.1. Control cells showed elongated mitochondria with yellow matrix, indicating mitochondrial fusion of the red and green matrices [1]. Cisplatin-treated cells exhibited fragmented mitochondria with reduced overlap of red and green signals, suggesting impaired fusion [2].
3.1.1. LAB MEDIA: Figure 6A. Video editor: Highlight the upper row of time-lapse images labeled “Control” 
3.1.2. LAB MEDIA: Figure 6A. Video editor: Highlight the lower row of time-lapse images labeled “Cisplatin Treated”
3.2. Fluorescence recovery in the photobleached region declined over time in control cells, indicating active mitochondrial fusion [1]. Cells treated with cisplatin maintained a nearly stable fluorescence ratio, indicating impaired mitochondrial fusion [2].
3.2.1. LAB MEDIA: Figure 6B. Video editor: Highlight the downward-sloping blue line representing “Control” 
3.2.2. LAB MEDIA: Figure 6B. Video editor: Highlight the red line labeled “Cisplatin treated”
3.3. The expression of CLRS-1 (C-L-R-S-One) was significantly reduced in cisplatin-treated cells compared to controls [1]. The expression of NRF1 (N-R-F-One) was significantly lower in cisplatin-treated cells than in controls [2].
3.3.1. LAB MEDIA: Figure 6C. Video editor: Highlight the first bar graph labeled “CLRS-1” and highlight the lower red bar (cisplatin treated) 
3.3.2. LAB MEDIA: Figure 6C. Video editor: Highlight the second bar graph labeled “NRF1” and highlight the shorter red bar (cisplatin treated) 
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